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Bedienungsanleitung  
DALIeco PC-Software 

Die DALIeco PC Software ermöglicht die komfortable Erstellung und Visualisierung 
individueller Konfigurationen für DALIeco Steuergeräte. Die Konfigurationen können über 
USB an den Speicher der Master Remote übertragen und danach per Knopfdruck in Form 
von IR Telegrammen an das Steuergerät gesendet werden. 
Darüber hinaus lassen sich einzelne Tasten der Master Remote sperren oder freigeben und 
die IR Codierung des Systems ändern. 
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Menü-Leiste Werkzeug-

Leiste 

Visualisierungs-

 / Vorschau-

Bereich 

Sprach- 

einstellung

Auswahl 

Grundfunktions- 

modus

Registerkarte 

Grundfunktionen 
Registerkarte 

Erweiterte Funktionen

Registerkarte 

Fernbedienungs-

einstellungen

Fortschrittsbalken

 
 
 
  



 
 

  Seite 2 von 15 
 

 
  

Menu Leiste 
 
 

Datei Menu 

 
 
Das Datei-Menü bietet folgende Möglichkeiten: 
 

 Erstellen eines Neuen Projekts (Alle Einstellung werden zurückgesetzt) 

 Öffnen eines existierenden Projektes:  
Ein Standard Datei Dialogfenster wird angezeigt und eine zuvor gespeicherte 
DALIeco Projektdatei (*.osrde) kann ausgewählt werden. 

 Speichern der Änderungen unter der aktuellen Projektdatei 

 Speichern der aktuellen Einstellungen unter einer neuen Projektdatei 

 Auswahl und Öffnen einer zuletzt geöffneten Datei  

 Schließen und Beenden der DALIeco PC Software 
 
 
 

Bearbeiten Menü 
 

 
 
Das Bearbeiten-Menü bietet folgende Möglichkeiten: 
 

 Rückgängig machen der letzten Aktion 

 Wiederholen letzten Aktion 

 RESET der aktuellen Konfiguration zu Standardeinstellungen 
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Übertragen Menü 
 

 
 
Das Übertragen-Menü bietet folgende Möglichkeiten: 
 

 Hochladen der aktuellen DALIeco Konfiguration in den Speicher der Master Remote 

 Hochladen der aktuellen Einstellung der Tastensperren an die Master Remote 
Control 

 Zurücksetzen der Master Remote Control: Löscht die Speicher von PC1 / PC2, dem 
Macrorecorder und setzt die Tastensperren zurück (= alle Tasten wieder freigegeben) 

 Auslesen der DALIeco Konfiguration aus dem Speicher der Master Remote 
Control 

 Auslesen der Tastensperren aus der Master Remote Control 

Hilfe Menü 

 
 
Das Hilfe-Menü bietet folgende Möglichkeiten: 
 

 Anzeigen der Hilfe Datei via PDF reader 

 Anzeige von Information über die installierte Version der  OSRAM DALIeco PC-
Software 

 
 

Spracheinstellung ändern 

 
 
Die Sprache der Oberfläche kann durch Klick auf das Flaggensymbol auf der rechten Seite 
der Menüleiste geändert werden.  
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Werkzeugleiste 
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Visualisierungsbereich 
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Der Visualisierungsbereich bietet eine Vorschau auf das “Licht über Zeit Verhalten“ der 
beiden DALI Kanäle. Die Y-Achse zeigt dabei die Dimmstellung und die X-Achse den 
Zeitfortschritt.  
Ausgelöst durch Ereignisse (z.B. erkannte Bewegung oder Ablauf eines Timers) wechselt 
das Steuergerät zwischen unterschiedlichen Zuständen. Art und Anzahl sind vom gewählten 
Grundfunktionsmodus und der individuellen Konfiguration abhängig. 
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Individuelle Funktionseinstellung 

Grundfunktionen 

 

Die Grundfunktionen umfassen die am häufigsten genutzten, grundlegenden Einstellungen. 
Folgende Parameter und Einstellungen sind verfügbar: 

DALI Kanal 
 

 Auto setup Pegel 
Der Auto setup Pegel ist der prozentuale Wert der Kunstbeleuchtung, den das 
Steuergerät für die tageslichtabhängige Regelung wählt, wenn die Taste “Auto setup” 
der Master Remote im Programmiermodus betätigt wird oder die im Sensor 
integrierte Taste für 10s gedrückt wird.  
Dieser Parameter ist nur verfügbar, wenn die Lichtregelung aktiviert ist (= auf 
Automatisch bzw. Halbautomatik gesetzt).  
 

 Einschaltpegel 
Der Einschaltpegel ist der Dimmwert von Kanal 1 bzw. Kanal 2, der beim Wechsel in 
den “ON” Zustand eingestellt wird.  
Dieser Parameter ist nur verfügbar, wenn die Lichtregelung auf „Aus“ gesetzt ist. 

 

 Ausschaltverzögerung  
Die Ausschaltverzögerung ist die Zeit, nach der das Steuergerät den „ON“ Zustand 
verlässt. Die Ausschaltverzögerungszeit wird durch Bewegungssignale oder manuelle 
Bedienung zurückgesetzt. 
 

 Stand-by 1 Pegel  
Dieser Wert wird nach Verlassen des “ON” Zustand eingestellt. Ist die Lichtregelung 
aktiv, ist der Prozentwert kein absoluter Wert, sondern der prozentuale Wert relativ 
zum gewählten Sollwert des „ON“ Zustands.  
Beispiel: Wenn der Stand-by Pegel auf 50% gesetzt wird, regelt das Steuergerät auf 
50% des für den “ON” Zustand vorgegebenen Sollwertes zurück. 
Ist die Lichtregelung auf “Aus” gesetzt, sind die Stand-by Pegel absolute Dimmwerte 
und können für Kanal 1 und 2 unabhängig voneinander eingestellt werden. 
Sind die Stand-by Werte auf “OFF” gesetzt, wird der Stand-by Zustand ausgelassen 
und das Steuergerät wechselt direkt in den Zustand “OFF”  
Anmerkung: 
- Ist die Lichtregelung aktiviert, sind die Kanäle über den gewählten „Offset“ 
miteinander verknüpft. 
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 Stand-by 1 Zeit 
Nach dieser Zeit wechselt die Beleuchtung entweder in den „Stand-by 2“ oder in den 
„OFF“ Zustand. 
 

 Offset 
Der Offset bezeichnet den prozentualen Unterschied zwischen Kanal 1 und Kanal 2. 
Beispiel: Ist der Offset auf 30% eingestellt, ist die Dimmstellung von Kanal 2 das 1,3 
fache des Kanals 1. 
Anmerkung: 
Ein Offset kann nur eingestellt werden, wenn die Lichtregelung aktiviert ist. 

 

Modi 
 

 Bewegungserkennung 
Drei unterschiedliche Einstellungen sind möglich: 

o Automatisch 
Die Beleuchtung schaltet ein, sobald der Erfassungsbereich betreten wird und 
schaltet automatisch wieder ab, nachdem der Bereich wieder verlassen wurde 
und die Nachlaufzeit abgelaufen ist.  
Anmerkung: Ist die Tageslichtregelung aktiv und ist der Tageslichtanteil 
ausreichend, schaltet die Beleuchtung durch Bewegungssignale nicht ein. 

o Halbautomatik 
Die Beleuchtung schaltet bei Bewegung nicht automatisch ein. Die 
Einschaltung muss z.B. durch Tasterbetätigung manuell erfolgen. 
Die Beleuchtung schaltet automatisch wieder ab, nachdem der Bereich wieder 
verlassen wurde und die Nachlaufzeit abgelaufen ist.  

o OFF 
Die Bewegungserfassung ist deaktiviert. 
 

 Lichtregelung 
Drei unterschiedliche Einstellungen sind möglich: 

o Automatisch 
Das Kunstlicht wird entsprechend des einfallenden Tageslichts und dem 
vorgegebenen Sollwert geregelt und bei ausreichendem Tageslicht 
ausgeschaltet. Bei nachlassendem Tageslicht schaltet die Beleuchtung 
selbständig wieder ein. 
Anmerkung: Ist die Bewegungserfassung aktiviert, erfolgt bei nachlassendem 
Tageslicht keine automatische Wiedereinschaltung wenn sich keine Personen 
im Erfassungsbereich befinden und die Nachlaufzeit abgelaufen ist.  

o Halbautomatik 
Die Beleuchtung schaltet nicht automatisch ein wenn die Beleuchtungsstärke 
bei nachlassendem Tageslicht den Sollwert unterschreitet. Die Einschaltung 
muss z.B. durch Tasterbetätigung manuell erfolgen. 

o OFF 
Die Lichtregelung ist deaktiviert. 
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Erweiterte Funktionen 

 

DALI Kanal 
 

 Stand-by 2 Pegel 
Dieser Zustand wird nach Verlassen des “Stand-by 1” Zustands eingestellt. Ist die 
Lichtregelung aktiv ist der Prozentwert kein absoluter Wert, sondern der prozentuale 
Wert relativ zum gewählten Sollwert des „ON“ Zustands.  
Beispiel: Wenn der Stand-by Pegel auf 50% gesetzt wird, regelt das Steuergerät auf 
50% des für den “ON” Zustand vorgegebenen Sollwertes zurück. 
Ist die Lichtregelung auf“Aus” gesetzt, sind die Stand-by Pegel absolute Dimmwerte 
und können für Kanal 1 und 2 unabhängig voneinander eingestellt werden. 
Sind die Stand-by Werte auf “OFF” gesetzt, wird der Stand-by Zustand ausgelassen 
und das Steuergerät wechselt direkt in den Zustand “OFF”  
Anmerkung: 
- Der Zustand „Stand-by 2“ ist nur verfügbar wenn der „Stand-by 1“ Zustand nicht auf 
„OFF“ gestellt. 
- Ist die Lichtregelung aktiviert, sind die Kanäle über den gewählten „Offset“ 
miteinander verknüpft. 
 

 Stand-by 2 Pegel 
Nach dieser Zeit wechselt die die Beleuchtung in den „OFF“ Zustand. 
 

 

Einstellungen Allgemein 

 
 100h Burn in 

Ist diese Einstellung aktiviert, verhindert das Steuergerät das Dimmen der 
Beleuchtung in den ersten 100h nach Inbetriebnahme.  
Ein Einbrennen wird für Leuchtstofflampen empfohlen und stellt das Erreichen der 
vollen Lebensdauer sicher. 
Anmerkung:  
Der Einbrennvorgang kann entweder durch Aktivieren des Programmiermodus der 
Master Remote und die anschließende Betätigung der “Burn-in” Taste oder der 
Deaktivierung der Funktion in der PC Software und anschließender Übertragung an 
das Steuergerät durch die Masterremote beendet werden. 
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 Kompensation der Lampenalterung 
Ist diese Funktion aktiviert und ist die Lichtregelung auf “OFF” gesetzt, erhöht das 
Steuergerät die DALI Werte aller Zustände alle 2.000 Brennstunden um einen Schritt.  
Anmerkung:  
Die Kompensation startet sobald neue Pegel für den “ON” Zustand programmiert 
werden. 
 

 PIR Sperrzeit 
Nach manueller Ausschaltung reagiert das Steuergerät nicht auf Bewegungssignale.  
Anmerkung:  
Die PIR Sperrzeit wird durch Bewegungssignale immer wieder zurückgesetzt. 
 

 Verhalten bei Netzunterbrechung 
Diese Einstellung bestimmt welcher Zustand bei Netzwiederkehr eingestellt wird.  
 

 Glättung Dimmen 
Mit dieser Einstellung kann das Dimmverhalten insbesondere bei LED Beleuchtung 
verbessert werden, indem eine DALI Fade Time für die angeschlossenen 
Vorschaltgeräte programmiert wird. 
Mögliche Einstellungen: 

o Keine  = DALI Fade time 0 
o Gering  = DALI Fade time 1 
o Mittel = DALI Fade time 2 
o Hoch = DALI Fade time 3 

 
 
 

Einstellungen Synchronisation  
 
Werden Steuergeräte miteinander verbunden, ist ein Austausch von Informationen zur 
Synchronisierung von Anlagen mit mehreren DALIeco Steuergeräten möglich. 
 

 Bewegungserkennung 
Ist diese Option aktiviert, tauschen die Steuergeräte Bewegungssignale aus und 
reagieren auf Bewegungssignale von anderen Steuergeräten.  
 

 Ein über Tasterkoppler 
Ist diese Option aktiviert, tauschen die Steuergeräte Einschaltbefehle aus, die durch 
Betätigung eines Tasters am Tastereingang C ausgelöst werden und reagieren auf 
entsprechende Ereignisse von anderen Steuergeräten.  
 

 Aus über Tasterkoppler 
Ist diese Option aktiviert, tauschen die Steuergeräte Ausschaltbefehle aus, die durch 
Betätigung eines Tasters am Tastereingang D ausgelöst werden und reagieren auf 
entsprechende Ereignisse von anderen Steuergeräten  

Einstellungen Tasterfunktionen 
 
Manuelles Dimmen über direkt oder über Tasterkoppler angeschlossene Taster 
unterbrechen die Tageslichtregelung. Die manuelle Dimmung über Taster kann deshalb über 
folgende Einstellungen gesperrt bzw. freigegeben werden: 
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 Dimmen über Tasterkoppler 
Ist diese Option aktiviert, kann die Beleuchtung über die Tasterkoppler gedimmt 
werden. 

 Dimmen über Tastereingang 
Ist diese Option aktiviert, kann die Beleuchtung über direkt angeschlossene Taster 
gedimmt werden. 

 Fernbedienungsfunktionen 
 
Diese Registerkarte ermöglicht das Sperren und Freigeben einzelner Tasten der Master 
Remote. In einem speziellen OEM Modus sind nur die PC 1 / PC 2 Tasten freigegeben.  
Zusätzlich kann die Infrarot Codierung des Systems geändert werden, so dass mehrere 
Systeme im gleichen Bereich sich unabhängig mit ihrer jeweiligen User Remote bedienen 
lassen. 
 

 
 

 Einstellung individueller Infrarot Codierungen 
Wird dieser Parameter auf eine bestimmte ID (1…15) gesetzt, reagiert das 
Steuergerät auf Fernbedienungen (User Remote) mit derselben ID. 
Anmerkungen: 
Das Steuergerät reagiert immer auf Fernbedienungen, die auf broadcast Codierung 
(=ID 16) eingestellt sind. 
Die ID der Master Remote selbst ist stets broadcast und wird durch die ID Einstellung 
nicht geändert. 
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Einstellung der User remote auf eine bestimmte ID: 

 
 
Rücksetzen der User Remote auf broadcast Betrieb
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 Einstellen des OEM Modus 
Der OEM Modus ermöglicht eine vereinfachte Programmierung von DALIeco 
Steuergeräten z.B. im Rahmen der Produktion von Leuchten. Ist der OEM Modus der 
Master Remote aktiviert, sind nur die beiden PC Mode Tasten der Fernbedienung 
freigegeben.  

 
 
Zusätzlich kann auch der PC1 oder PC2 Knopf individuell gesperrt oder freigegeben 
werden. Im OEM Modus kann die Konfiguration über einen einzigen Tastendruck auf 
PC1 oder PC2 übertragen werden, ohne dass zuvor in den Programming Modus 
gewechselt werden muss.  
 
 

 Sperren und Freigeben von Tasten der Master Remote 
Alle Tasten können durch Anklicken auf der Fernbedienungsgrafik freigegeben bzw. 
gesperrt werden. Der „Freigegeben“ / “Gesperrt” Zustand wechselt mit jedem 
Mausklick. Eine Gesperrte Taste wird dunkelgrau hinterlegt dargestellt.  
 

Freigegebene

Taste

Gesperrte

Taste

 
 
Alle Tasten können über die Funktion „Fernbedienungstastensperren zurücksetzen“ mit 
einem Klick wieder freigegeben werden. 
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Erstellen und Übertragen einer vollständigen Konfiguration 
 

Schritt 1: Erstellen eines neuen Projekts (optional) 
 

Erstellen Sie ein neues Projekt durch Mausklick auf das Symbol in der Werkzeugleiste 
oder über den entsprechenden Eintrag im „Datei“-Menü.  
 
 

Schritt 2: Wählen eines Grundfunktionsmodus 
 
Wählen Sie den Funktionsmodus durch Mausklick auf die entsprechende Fläche der 
nachfolgenden Grafik 

 
 
 
 
 
 
 
 
 

Schritt 3: Anpassung individueller Parameter (optional) 
Ändern Sie die entsprechenden Parametereinstellungen auf den Registerkarten 
“Basisfunktionen” oder “Erweiterte Funktionen”. 

Schritt 4: Übertragung der Einstellung an den Speicher der Master Remote 
 

1. Stellen Sie sicher, dass die Fernbedienung über USB mit dem PC verbunden ist  
Anmerkung:  
Bitte verwenden Sie dazu ausschließlich das Original OSRAM USB Kabel mit 
integrierter USB Treiber Elektronik! 
 

2. Wählen Sie “DALIeco Konfiguration hochladen” aus dem “Übertragen” Menü bzw. 
Klicken Sie auf das entsprechende Symbol in der Werkzeugleiste. 
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3. Wählen Sie das Speicherziel  

 

 
Anmerkung: Der PC mode 1 Speicher entspricht der PC1 Taste, PC mode 2 Speicher 
der PC2 Taste der Master Remote. 
 

4. Wählen Sie die Option „Alle Funktionseinstellungen“ 
 

 
 

5. Klicken Sie auf “OK”, um die Übertragung zu starten. 
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Einstellung und Übertragung einzelner Parameter  
Soll nur ein einziger bzw. einzelne Parameter an das Steuergerät übertragen werden, 
müssen die nachfolgenden Schritte ausgeführt werden. 

Schritt 1 Wählen Sie einen geeigneten Grundfunktionsmodus 
 

Wählen Sie den Funktionsmodus durch Mausklick auf die entsprechende Fläche der 
nachfolgenden Grafik 
 
 
 
 
 
 
 
 

Schritt 2 Einstellen der individuellen Parameter 
 
Ändern Sie die entsprechenden Parametereinstellungen auf den Registerkarten 
“Basisfunktionen” oder “Erweiterte Funktionen”. 

Schritt 3 Übertragung der individuellen Parameter an die Master Remote 
1. Stellen Sie sicher, dass die Fernbedienung über USB mit dem PC verbunden ist  

 
Anmerkung:  
Bitte verwenden Sie dazu ausschließlich das Original OSRAM USB Kabel mit 
integrierter USB Treiber Elektronik! 

 
2. Wählen Sie “DALIeco Konfiguration hochladen” aus dem “Übertragen” Menü bzw. 

Klicken Sie auf das entsprechende Symbol in der Werkzeugleiste. 
  
  
  
  
  
  
  
  
 

  
 

3. Wählen Sie das Speicherziel 

 
Anmerkung: Der PC mode 1 Speicher entspricht der PC1 Taste, PC mode 2 Speicher 
der PC 2 Taste der Master Remote. 
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4. Wählen Sie die Option „Einzelparameter“ 

 
 

5. Wählen Sie die zu übertragenden Parameter 

 
In diesem Beispiel wird nur die Ausschaltverzögerung, Stand-by 1 Zeit und Stand-by 
1 Pegel übertragen. 
 

6. Klicken Sie auf “OK” um die Übertragung zu starten. 

Allgemein 
 
Informationen zur Version der Software und entsprechende Release Notes können über den 
Eintrag “Info über OSRAM DALIeco PC-Software” im „Hilfe“ Menü aufgerufen werden.  
Das Softwarehandbuch kann durch Mausklick auf den Eintrag „Hilfe anzeigen“ als PDF- 
Dokument angezeigt werden. 
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User Manual DALIeco PC-Software 

The DALIeco PC software allows a comfortable creation and vizualisation of individual 
configurations for the DALIeco control unit. Configurations can be uploaded to the memory of 
the DALIeco master remote via USB and subsequently transmitted on a single button press 
to the control unit by IR telegrams.  
In addition to that buttons of the master remote can be disabled or enabled and the IR code 
of the control system can be changed. 

Graphic user interface (GUI) layout 
 

Menu bar
Tool bar

Vizualsiation / 

preview area

Language 

setting

Base mode 

selection

Base functions tab

Advanced functions tab

Remote control functions tab

Progress bar
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Menu bar 
 
 

File Menu 

 
 
The File menu bar offers the following options 
 

 Create a New project (all settings of the GUI will be reset to default) 

 Open an existing project:  
A standard file selection window will be displayed and a previously stored DALIeco 
project file (*.osrde) can be selected 

 Save current changes to the current project file 

 Save current settings as a new project file 

 Select and open one of the recently opened files  

 Close and Exit the DALIeco PC Software 
 
 
 

Edit Menu 
 

 
 
The Edit menu bar offers the following options 
 

 Undo last action 

 Redo last action  

 RESET current configuration settings to default 
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Transfer Menu 
 

 
 
The Transfer menu bar offers the following options 
 

 Upload the current DALIeco Configuration to the memory of the master remote 

 Upload the current enabled / disabled Key settings to the Master Remote Control  

 Reset the enabled / disabled Key settings of the Master Remote Control (= all keys 
enabled 

 Download the DALIeco Configuration settings from the memory of the master 
remote to the PC  

 Download the enabled / disabled Key settings from the Master Remote Control to 
the PC 

 

Help menu 
 

 
 
The Help menu bar offers following options 

 Show help file via PDF reader 

 Display information About the OSRAM DALIeco PC-Software 
 
 

Change language  

 
 
The language of the GUI can be changed by clicking onto the flag icon on the right side of 
the menu bar 
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Tool bar 
 

Create a 

new project

Open a new

project

Save 

current 

project to a 

new location

Undo last 

action

Redo last 

action

RESET all 

settings to default

Upload 

configuration to 

the master remote

Upload key lock 

settings to the 

master remote

Enable all keys of 

the master remote

Download configuration 

to the PC

Download the key lock 

settings to the PC

 
 
 

Vizualisation area 
 
 

States

Light is off

Light is on

Event Timer setting 
Time axis

Dimming 

level axis

Dimming level 

DALI channel 1 

Dimming level 

DALI channel 2  
 
The vizualisation area provides a preview of the “light over time behavior” of the two DALI 
channels. While the Y-axis shows the dimming level, the X-axis reflects the progressing time. 
Triggered by events (e.g. detected motion or an expired timer) the control unit changes 
between different states. Types and number of the depicted states depend on the selected 
base mode and the individual configuration. 
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Individual functions setting 

Base functions 
 

 
 
The base functions represent the most important and most common parameter settings.  
The following parameters are available: 
 

DALI channel 
 

 Auto setup level 
The Auto setup level is the percentage of the artificial light that the controller will 
choose as a setpoint for the daylight dependent closed loop control, when the “Auto 
setup” button of the master remote is pressed during programming mode or the 
sensor integrated button is pressed for more than 10s. 
This parameter is only available if the “Light regulation” is activated (= set to 
“Automatic” or “Semi automatic”). 
 

 On level 
The On level is the dimming level of channel 1 respectivly of channel 2 that the 
controller will establish when it changes to the “ON” state. 
Remark: This parameter is only available if the “Light regulation” is set to “OFF”  
 

 Switch off delay 
The Switch off delay is the time after that the controller will leave the “ON” state.  
The Switch off delay time is retriggered by motion signals or manual user operations. 
 

 Stand-by 1 level 
This level will be established after leaving the “ON” state. If the light regulation is  
activated the percentage value is not an absolute dimming level but a relative value to 
the setpoint.  
Example: If the Stand-by level is set to 50%, the controller will reduce the regulation 
down to 50% of the regulation level choosen for the “ON” state. 
If light regulation is set to “OFF”, the Stand-by levels are absolute values and can be 
set differently for channels 1 and 2. 
If the Stand-by level is set to “OFF” the controller will skip the “Stand-by 1” state and 
directly change to the “OFF state”. 
Remark: 
- If light regulation is enabled channels 1 and 2 are linked by the choosen offset. 
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 Stand-by 1 time 
This is the time after that the controller will leave the “Stand-by 1” state and either 
change to “Stand-by 2” or “OFF” state. 
 

 Offset 
The Offset is the percentual difference in light output between channel 1 and channel 
2. Example: If the offset is set to 30%, the dimming level of channel 2 is 0.3 x higher 
than the dimming level of channel1. 
Remark: 
An Offset can only be configured if the light regulation is set to automatic or semi 
automatic. 

 

Modes 
 

 Motion detection 
Three different settings are possible: 

o Automatic 
Light will switch on if somebody enters the detection area and will switch off if 
no motion is detected and the delay time expired.  
Remark: If daylight regulation is active and the amount of incoming daylight is 
sufficient, the light will not be switched on by motion signals. 

o Semi automatic 
Light will not switch on if somebody enters the detection area, switching on 
requires a manual action by the user e.g. pressing the push button. Light will 
switch off if no motion is detected and the delay time expired 

o OFF 
Motion detection is disabled 
 

 Light regulation 
Three different settings are possible: 

o Automatic 
Light will be regulated according to incoming daylight and the setpoint, it will 
be switched off if the amount of daylight is sufficient. If the amount of daylight 
decreases below set point light will switch on automatically. 
Remark: If motion detection is enabled, automatic switch on by decreasing 
daylight is disabled when no persons are within the detection area and the 
delay timer has expired.  

o Semi automatic 
Light will not switch on if the amount of daylight falls below the regulation set 
point. Switching on requires a manual action by the user e.g. pressing the 
push button.  

o OFF 
Light regulation is disabled 
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Advanced functions 

 
 

DALI channel 
 

 Stand-by 2 level 
This level will be established after leaving the “Stand-by 1” state. If the light regulation 
is activated the percentage value is not an absolute value but a relative value to the 
choosen setpoint. Example: If the Stand-by level is set to 50%, the controller will 
reduce the regulation down to 50% of the regulation level choosen for the “ON” state. 
If light regulation is set to “OFF”, the Stand-by levels are absolute values and can be 
set differently for channels 1 and 2. 
If the Stand-by 2 level is set to “OFF” the controller will skip the “Stand-by 2” state and 
directly change to the “OFF state”. 
Remarks:  
- The Stand-by 2 level is only available if the Stand-by 1 level is not set to “OFF”. 
- If light regulation is enabled channels 1 and 2 are linked by the choosen offset of the 
“ON” state. 
 

 Stand-by 2 time 
This is the time after that the controller will leave the “stand-by 2” state and change to 
“OFF” state. 

 

Settings General 

 
 

 100h burn in 
If this function is enabled, the controller will block dimming for 100h.  
A burn in is recommended especially for low pressure discharge fluorescent lamps to 
achieve proper dimming quality and the full lamp lifetime.  
Remark:  
The burn in process can only be interrupted by either entering the programming mode 
and pressing the burn in button of the master remote or by disabling this function and 
transfer this setting to the controller by the master remote. 
 

 Automatic compensation of lamp aging 
If this function is enabled and the light regulation is set to “OFF” the controller will 
increase the DALI levels of all stages by one step every 2.000 burning hours  
Remark:  
The compensation starts when new levels for the “ON” state are programmed. 
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 PIR inhibit time 
This time defines how long motion signals will be ignored and do not lead to a switch 
on after manually switching off by the user.  
Remark:  
The PIR inhibit timer is retriggered by each motion signal. 
 

 State after power failure 
This setting defines the power up state the controller will establish after a mains 
voltage interruption. 
 

 Smoothing of dimming 
This parameter allows to improve the dimming performance especially of LED 
solutions by programming a DALI Fade time to the connected ballasts. 
Following settings are possible: 

o None = DALI Fade time 0 
o Low = DALI Fade time 1 
o Medium = DALI Fade time 2 
o High = DALI Fade time 3 

 
 

Settings Synchonization 
 
If control units are interconnected, an exchange of information is possible which allows a 
synchronous behavior of lighting control installations consisting of multiple DALIeco 
controllers. 
 

 Motion detection 
If this function is enabled, the control unit will share own motion signals with the 
interconnected units and react on motion signals from other units. 
 

 On via push button coupler 
If this function is enabled, the control unit will share the switch on event by a press on 
the push button connected to push button coupler input C and react to corresponding 
switch on events from push button couplers from other units. 
 

 Off via push button coupler 
If this function is enabled, the control unit will share the switch off event by a press on 
the push button connected to push button coupler input D and react to corresponding 
switch off events from push button couplers from other units. 

 

Settings Push button function 
 
Manual dimming by directly connected push buttons or via push button couplers interrupt the 
automatic daylight regulation.  
This possibility can be enabled / disabled by following settings: 
 

 Dimming via push button coupler 
If this setting is enabled, a manual dimming / interruption of light regulation via push 
buttons connected to the push button coupler is possible. 

 Dimming via push button input 
If this setting is enabled, a manual dimming / interruption of light regulation via push 
buttons directly connected to the DALIeco control unit is possible. 
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Remote control functions 
 
The remote control functions tab allows enabling / disabling dedicated buttons of the master 
remote. In a special OEM mode only the PC 1 / PC 2 buttons are enabled.  
In addition the IR coding of the system can be changed, to allow multiple systems within the 
same area each independently controlled by its own user remote. 
 
 

 
 

 Setting the User Remotes control ID 
If this parameter is set to an individual ID (1…15) the control unit will react to user 
remotes with the same ID. 
Remarks: 
The control unit will always react to remotes with broadcast (=ID 16) setting. 
The ID of the master remote itself is always broadcast and is not affected by the 
control ID setting. 
 

Configuration of a user remote to a specific ID: 

 
Reset user remote to broadcast 
1. Simultaneously press (VLP) [CH-1 ▲] and [Resume] (LED flashes red). 
2. Press the [4] button (SP) – (LED red/green is orange for 3 seconds). 
 

 Selecting the OEM Mode 
The OEM mode allows a simpilfied programming of DALIeco during the luminaire 
production process. Selecting the OEM mode only the two PC mode buttons of the 
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master remote are enabled.  

 
 
On demand PC1 or PC2 button can be disabled individually. 
Within the OEM mode the configuration can be transmitted by a single button press 
onto the PC1 or PC2 button without entering the programming mode.  
 
 

 Locking / unlocking master remote keys 
All keys can be enabled/unlocked or disabled/locked by clicking onto the depicted key 
of the master remote picture. The lock / unlock status changes at every click. 
A disabled/locked key is highlighted in dark grey. 
 

Enabled/unlocked 

key

Disabled/locked 

key

 
 
All keys can be enabled/unlocked by the”Reset remote control key locks” button 
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Setup and transfer a complete configuration 
 

Step 1 create a new project (optional) 
 

Create a new project by clicking on the icon on the tool bar or the file menu  
 
 

Step 2 select base operation mode 
 
Select the base operating mode that corresponds to the target application by clicking on one 
of the keys  
 
 
 
 
 
 
 
 
 

Step 3 adjust individual parameters 
 
Change parameters on the “Base functions” or the “Advanced functions” tabs as required. 
 
 

Step 4 Transfer to the configuration to the master remote 
 

1. Check if Master remote is connected to the PC via USB  
Remark:  
Please use the original OSRAM USB cable with integrated USB driver Chip only! 
 

2. Choose the “Upload DALIeco Configuration” from the transfer menu or the 
corresponding icon from the menu bar  
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3. Select the storage target 
 

 
Remark: PC mode 1 storage corresponds with the PC1 button, PC mode 2 storage 
with the PC 2 button of the master remote. 
 

4. Select the transfer of all function settings 
 

 
 

5. Press “OK” to start the transfer. 
 

 

Setup and transfer an individual parameter 
If only a single or a couple of parameters should be transferred to the DALIeco control unit 
the following steps have to be performed.  
 

Step 2 select a suitable base operation mode 
 
Select the base operating mode that offers the setting possibility for the corresponding 
parameters by clicking on one of the keys  
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Step 3 adjust individual parameters 
 
Change the corresponding parameters on the “Base functions” or the “Advanced functions” 
tabs as required. 
 

Step 4 Transfer the individual parameters to the master remote 
 

1. Check if Master remote is connected to the PC via USB  
Remark:  
Please use the original OSRAM USB cable with integrated USB driver Chip only! 
 

2. Choose the “Upload DALIeco Configuration” from the transfer menu or the 
corresponding icon from the menu bar  
  
  
  
  
  
  
  
  
  
 

3. Select the storage target 
 

 
Remark: PC mode 1 storage corresponds with the PC1 button, PC mode 2 storage 
with the PC 2 button of the master remote. 
 

4. Select the transfer of single parameters 
 

 
 



 

  Seite 14 von 14 
 

 
  

5. Select the parameters that should be transferred 

 
In this example only the Switch off delay time and the Stand-by 1 time will be 
transmitted. 
 

6. Press “OK” to start the transfer. 

Miscellanous 
 
For information about the software version and display of release notes please click  
on the “About OSRAM DALIeco PC-Software” entry in the “Help” Menu. 
 
To open the user manual as a PDF document please select the „Show help“ entry. 
 

 
 


